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Description

Summary description

The IBM® Lotus® Symphony™ 1 Training Kit was developed to give you the tools
needed to facilitate training sessions and enable new users of Lotus Symphony.
It is designed to offer training on the three Lotus Symphony products:

m  |IBM® Lotus® Symphony™ Documents
m IBM® Lotus® Symphony™ Presentations
m  IBM® Lotus® Symphony™ Spreadsheets

Course format and duration

The training materials in this kit can be used to present enablement sessions in
classroom or online environments.

m Facilitator-led, classroom based: The facilitator presents course materials
to a group of students in a classroom or meeting room. The student materials
provide extensive background information, procedural tables, and best
practice tips. The Facilitator Guide provides instructions for setting up,
preparing, and delivering the seminar.

m Facilitator-led, e-learning: The facilitator uses the tools of the e-learning or
web conference environment to present course materials to a group of
students in a live, online session. Course materials include presentation files
for display, scripts for demonstrations conducted using the screen sharing
tools, student materials, and facilitator materials.

This Facilitator Guide provides the instruction and information you need to install,
prepare, and deliver the facilitator-led courses.

Audience

This course is designed for computer users who have basic understanding of
spreadsheets, word processors or presentation applications. Some students
may have extensive Microsoft Office skills but this is not a requirement.
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Description...(continued)

Prerequisites

To be successful in completing the workshops, students should have basic
experience working with spreadsheets, word processors or presentation
applications.

For most effective participation, students should have a computer, with Lotus
Symphony products installed. This computer should be available where the
student will participate in the training, either a classroom, meeting room or, if
attending virtually, in their location.
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Course Outline

This seminar is developed as nine one-hour modules which can be presented:

m  As independent sessions
m  Combined to present more comprehensive training events
m As one continuous training session, delivered in one and one half days.

Each Lotus Symphony product is addressed in 3 modules, each of which is
targeted to a skill level:

m Basics: Content is designed to get users started using the simple
functionality of the product.

m  Beyond basics: Intermediate content is presented for users who have some
experience with word processing, presentation, or spreadsheet applications.

m  Power user: Advanced content designed for the experienced user who will
take advantage of complex features and functionality.

Combining modules

You may select and present the learning modules that meet your organization’s
learning needs. Some delivery scenarios include:

m  You present only the Lotus Symphony Documents modules if your
organization will use that product only.

m  You present the Basics modules first. Then, a few months later, when the
organization has been using the applications, you lead sessions to present
the Beyond Basics and Power User modules.

m  Beyond Basic and Power User sessions are run periodically, for users who

want to increase their product skills.

The following table shows some options for presenting content:

m By product
m By skill level

Lotus Symphony
Documents

+ Basics

+

Beyond Basics

+ Power User

Half-day course

Lotus Symphony
Presentations

+ Basics

+

Beyond Basics

+ Power User

Half-day course

Lotus Symphony

Spreadsheets
+ Basics = Half-day course
+ Beyond Basics = Half-day course

+ Power User Half-day course

Half-day course
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Course Outline...(continued)

The following table shows a sample agenda when the modules are presented in
one, continuous, comprehensive training session.

Note: It is assumed that breaks will be taken during the time allotted to complete
independent activities

Day one

Time Module
9:00 - 10:00 Using IBM® Lotus® Symphony™ Documents: Basics
10:00 — 11:00 Using IBM® Lotus® Symphony™ Documents: Beyond Basics
11:00 — 12:00 Using IBM® Lotus® Symphony™ Documents: Power User

12:00 — 1:00 Lunch
1:00 — 2:00 Using IBM® Lotus® Symphony™ Presentations: Basics
2:00 - 3:00 Using IBM® Lotus® Symphony™ Presentations: Beyond Basics
3:00 - 4:00 Using IBM® Lotus® Symphony™ Presentations: Power User
Day Two
Time Module

9:00 - 10:00 Using IBM® Lotus® Symphony™ Spreadsheets: Basics
10:00 — 11:00 Using IBM® Lotus® Symphony™ Spreadsheets: Beyond Basics
11:00 - 12:00 Using IBM® Lotus® Symphony™ Spreadsheets: Power User
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Course Outline...(continued)

Approach

This seminar is designed for facilitator-led delivery in a classroom environment or
using the tools of an e-learning environment, in a live, online session. This guide
addresses the setup, preparation, and delivery tasks for classroom and e-
learning delivery.

Each instructional unit is comprised of lessons, which contain instruction and
guided practices. Facilitators use presentation software to present conceptual
slides and introduce guided practices.

In the classroom environment, students complete the guided practices
independently. In the e-learning environment, the facilitator can present the
guided practices or use application sharing to invite students to participate.
Optionally, the e-learning facilitator may assign practice activities to students for
independent completion.

Student materials are provided which contain informational, procedural, and
conceptual instruction.

Tips for delivery

Consider the following tips when leading a training session.

m Extend the first session by 30 minutes and use the time to help users
download and install Lotus Symphony.

m  Depending on your audience and the delivery environment (classroom or
online) you may choose to deliver activities as demonstrations, guided
activities, or independent activities.

m  When delivering a demonstration or guided activity, pause to ask for
guestions and to ensure that students are on pace with you.

m  When facilitating independent activity, be available to offer help and to
answer questions.

m If certain Lotus Symphony features seem particularly applicable to your
organization's use, lead a brief discussion on how your organization can best
utilize the functionality. For instance, Lotus Symphony allows you to create
document and presentation templates. You might ask the class participants
how you will share templates created by team members.
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Additional Information

For additional information and training on Lotus Symphony, navigate to the IBM
Lotus Symphony web site. http://symphony.lotus.com

Click the Help tab to display the options shown in the following figure:

Lotus Symphony Documents
A FAQs | Demos | Tutorial | Take a Tour* | Technotes

Th Toolbar Reference Card” | fH) Keyboard Reference
Card”

Lotus Symphony Presentations
]%[ FAQs | Demos | Tutorial | Take a Tour* | Technotes

T Toolbar Reference Card® | fH Keyboard Reference
Card”

Lotus Symphony Spreadsheets
ol FAQs | Demos | Tutorial | Take a Tour™ | Technotes

T Toolbar Reference Card* | ) Keyboard Reference
Card”

The following additional resources are available from this page:

m  Tours: Media-based training and demonstrations on Lotus Symphony
products.

Demonstrations: Media demonstrations of common tasks
Tutorial: Step-by-step instructions for completing specific tasks.
Reference card: Reference information that can be downloaded and printed

In addition, you can download the IBM® Lotus® Symphony”™ Installation Guide.
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Course Materials

Facilitator materials

The following tables list and describe the content of the facilitator materials.

Note: All guides are provided as pdf and source odf file formats.

Facilitator Guide

Filename

Document title

Y13001INST.pdf = Using IBM® Lotus® Symphony Facilitator Guide

IBM Lotus Symphony Student Guides

The student guides include the presentation handouts with speaker notes. In
addition, the guides may contain a reference card for the Lotus Symphony
product. There is one guide for each module

You may want to print this guide in case you need to reference page numbers
when helping students find their place in the presentation.

The following table lists each of the student guides and filenames.

Filename
Y13001Documents_BasicsSTUD.pdf
Y13001Documents_BasicsSTUD.odt
Y13001Documents_BeyondBasicsSTUD.pdf
Y13001Documents_BeyondBasicsSTUD.odt
Y13001Documents_PowerUserSTUD.pdf
Y13001Documents PowerUserSTUD.odt

Y13001Presentations_BasicsSTUD.pdf
Y13001Presentations_BasicsSTUD.odt
Y13001Presentations_BeyondBasicsSTUD.pdf
Y13001Presentations_BeyondBasicsSTUD.odt
Y13001Presentations_PowerUserSTUD.pdf
Y13001Presenations_PowerUserSTUD.odt

Y13001Spreadsheets_BasicsSTUD.pdf
Y13001Spreadsheets BasicsSTUD.odt
Y13001Spreadsheets_BeyondBasicsSTUD.pdf
Y13001Spreadsheets_BeyondBasicsSTUD.odt
Y13001Spreadsheets_PowerUserSTUD.pdf
Y13001Spreadsheets_PowerUserSTUD.odt
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Document title
Using IBM® Lotus® Symphony™ Documents: Basics

Using IBM® Lotus® Symphony™ Documents: Beyond Basics

Using IBM® Lotus® Symphony™ Documents: Power User

Using IBM® Lotus® Symphony™ Presentations: Basics
Using IBM® Lotus® Symphony™ Presentations: Beyond

Basics

Using IBM® Lotus® Symphony™ Presentations: Power User

Using IBM® Lotus® Symphony™ Spreadsheets: Basics
Using IBM® Lotus® Symphony™ Spreadsheets: Beyond

Basics

Using IBM® Lotus® Symphony™ Spreadsheets: Power User
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Course Materials...(continued)

Facilitator materials...

IBM Lotus Symphony presentation files

The following table lists each of the presentation files and filenames.

Filename
Y13001Documents_BasicsSHOW.odp

Y13001Documents_BeyondBasicsSHOW.
odp
Y13001Documents_PowerUserSHOW.odp

Y13001Presentations_BasicsSHOW.odp

Y13001Presentations_BeyondBasicsSHO
W.odp

Y13001Presentations_PowerUserSHOW.o
dp

Y13001Spreadsheets_BasicsSHOW.odp

Y13001Spreadsheets_BeyondBasicsSHO
W.odp

Y13001Spreadsheets PowerUserSHOW.o
dp

Document title
Using IBM® Lotus® Symphony ™
Documents: Basics
Using IBM® Lotus® Symphony™
Documents: Beyond Basics

Using IBM® Lotus® Symphony™
Documents: Power User

Using IBM® Lotus® Symphony™
Presentations: Basics

Using IBM® Lotus® Symphony™
Presentations: Beyond Basics
Using IBM® Lotus® Symphony™
Presentations: Power User

Using IBM® Lotus® Symphony™
Spreadsheets: Basics

Using IBM® Lotus® Symphony ™
Spreadsheets: Beyond Basics
Using IBM® Lotus® Symphony™
Spreadsheets: Power User

Note: To create a delivery guide, print the presentation files with speaker notes.

Instructions to do this are on page 17.
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Exercise files

Some modules include activities that require exercise files to complete. These
files are included in this training kit.

The following table lists the exercise files used for each module:

Document title
Using IBM® Lotus® Symphony™
Documents: Basics

Using IBM® Lotus® Symphony™
Documents: Beyond Basics

Using IBM® Lotus® Symphony™
Documents: Power User

Using IBM® Lotus® Symphony™
Presentations: Basics

Using IBM® Lotus® Symphony ™
Presentations: Beyond Basics
Using IBM® Lotus® Symphony™
Presentations: Power User

Using IBM® Lotus® Symphony™
Spreadsheets: Basics

Using IBM® Lotus® Symphony™
Spreadsheets: Beyond Basics

Using IBM® Lotus® Symphony™
Spreadsheets: Power User

Files used in this module
Quarterly Report Start File.odt
Quarterly Report — BasicsL2.odt
Quarterly Report Beyond Basics.odt
Wwcorplogo.png
Annual Report with Tables.doc

wwcorp_3rdQT_presentation.odp
wwcorp_std.odp

final_exec_pres.odp

Quarterly Report_Beyond Basics.odp

Quarterly Report_Power User.odp

Sales July to Dec — BasicsL2.0ds

TopSalesReport.ods
TopSalesReport — BeyondL2.ods
wwcorplogo.png

TopSalesReport — PowerlL1.0ds
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Course Materials...(continued)

Student materials

IBM Lotus Symphony Student Guides

The student guides include the presentation handouts with speaker notes. In
addition, the guides may contain a reference card for the Lotus Symphony
product. There is one guide for each module

The following table lists each of the student guides and filenames.

Filename Document title
Y13001Documents_BasicsSTUD.pdf Using IBM® Lotus® Symphony™
Y13001Documents_BasicsSTUD.odt Documents: Basics
Y13001Documents_BeyondBasicsSTUD.pdf Using IBM® Lotus® Symphony™
Y13001Documents_BeyondBasicsSTUD.odt Documents: Beyond Basics
Y13001Documents_PowerUserSTUD.pdf Using IBM® Lotus® Symphony™
Y13001Documents_PowerUserSTUD.odt Documents: Power User

Y13001Presentations_BasicsSTUD.pdf Using IBM® Lotus® Symphony™
Y13001Presentations_BasicsSTUD.odt Presentations: Basics
Y13001Presentations_BeyondBasicsSTUD.pdf ~ Using IBM® Lotus® Symphony™
Y13001Presentations_BeyondBasicsSTUD.odt Presentations: Beyond Basics
Y13001Presentations_PowerUserSTUD.pdf Using IBM® Lotus® Symphony™
Y13001Presenations_PowerUserSTUD.odt Presentations: Power User

Y13001Spreadsheets_BasicsSTUD.pdf Using IBM® Lotus® Symphony™
Y13001Spreadsheets_BasicsSTUD.odt Spreadsheets: Basics
Y13001Spreadsheets_BeyondBasicsSTUD.pdf ~ Using IBM® Lotus® Symphony™
Y13001Spreadsheets_BeyondBasicsSTUD.odt Spreadsheets: Beyond Basics
Y13001Spreadsheets_PowerUserSTUD.pdf Using IBM® Lotus® Symphony™
Y13001Spreadsheets PowerUserSTUD.odt Spreadsheets: Power User
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Course Materials...(continued)

Student materials...

Exercise files

The following table lists the exercise files used for each module:

Module
Using IBM® Lotus® Symphony™
Documents: Basics

Using IBM® Lotus® Symphony™
Documents: Beyond Basics

Using IBM® Lotus® Symphony™
Documents: Power User

Using IBM® Lotus® Symphony™
Presentations: Basics

Using IBM® Lotus® Symphony™
Presentations: Beyond Basics
Using IBM® Lotus® Symphony™
Presentations: Power User

Using IBM® Lotus® Symphony™
Spreadsheets: Basics

Using IBM® Lotus® Symphony™
Spreadsheets: Beyond Basics

Using IBM® Lotus® Symphony™
Spreadsheets: Power User

File name
Quarterly Report Start File.odt
Quarterly Report — BasicsL2.odt
Quarterly Report Beyond Basics.odt
Wwcorplogo.png
Annual Report with Tables.doc

wwcorp_3rdQT_presentation.odp
wwcorp_std.odp

final_exec_pres.odp

Quarterly Report_Beyond Basics.odp

Quarterly Report_Power User.odp

Sales July to Dec — BasicsL2.0ds

TopSalesReport.ods
TopSalesReport — BeyondL2.ods
wwcorplogo.png

TopSalesReport — PowerlL1.0ds
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Preparing to Teach

Before the training session

A few days before you deliver the training session you should complete the tasks
listed in the following table.

Task Procedure

a 1 Send participants an email that includes:

m Instructions to download the Lotus Symphony applications from
http://symphony/lotus.com

®m  Reminder to bring a laptop computer to the session, so they can
complete the activities.

m  Confirmation of session location and time.

m  Contact information so they can reach you if they have problems
of questions.

m  Exercises file attachments for those activities that you will present
in the session.

a 2 Confirm that the room, where you will conduct the training, has:
m A projection system and the required cables for connecting your
computer.

m Internet access for the facilitator, used to demonstrate the Lotus
Symphony Web site.
Note: If students download the Lotus Symphony applications
prior to the training session, they will not need an internet

connection.
®  Enough seating for all participants.
a 3 Print student guides.
a 4 Print the speaker notes.

Printing speaker notes

Follow these instructions to print speaker notes from the presentation files.

Task Procedure
1 Open a presentation file.
2 Click File->Print Preview..
3 In the tool bar, select Notes layout.
4 Click File->Print.
5 Click the printer Properties and change the page layout to Portrait.
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Preparing to Teach...(continued)

Setting up the classroom

Before starting the workshop you should complete the tasks listed in the

following table.

Task Procedure

a 1 Install the course files to your computer.

a 2 Connect your computer to a monitor or projector in the classroom or
meeting room where you will deliver the session.

d 3 Display a few slides to ensure the projection system is functioning
properly.

a 4 Practice switching your display between presentation and
demonstration applications.

a 5 Ensure you have internet connection and can display the Symphony
website. http://symphony/lotus.com

a 6 Distribute student guides and exercise files.

Preparing to teach

Consider these tips when preparing to teach these workshop modules.

Familiarize yourself with the software.

Review the training tours, demos and videos available on the http://
symphony/lotus.com website.

m  Practice presenting the module content, until you are comfortable with the
concepts, vocabulary, and procedures.
Practice completing the course activities.
Review all the course modules, even if you don't plan to teach all the content.
This will help you direct students when they ask questions that may be
addressed in other modules.

© Copyright IBM Corporation 2008



IBM® Lotus® Symphony™ 1 Training Kit

Facilitator Guide

Preparing to Teach...(continued)

Starting the session

Consider these tips when starting a training session:

Welcome students and conduct introductions

Poll your students to assess the experience level of each student.
Review the session goals.

Encourage questions and interaction.

Concluding the session

Consider these tips when concluding a training session:

m  Promote follow-on sessions and poll participants to assess interest.

m I|dentify peer experts who have advanced skills and knowledge, who may be
able to provide support.

After the session

If you are conducting enablement for your organization, consider these tips:

m Create a support site where users can post questions, tips, templates, and
other information about using Lotus Symphony.

m  Send an email to participants one to three weeks after the session to solicit
guestions, find out about usage, and identify additional enablement needs.

m  Schedule additional sessions to present more advanced modules or
additional Lotus Symphony application training.
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E-learning Instructor Preparation

Additional tasks should be completed to prepare and deliver this course in a live,
online session. This section lists some preparation tasks for preparing to teach
online.

Presenting in a live session in an e-learning environment

Presenting a synchronous course online can be challenging. Always ensure that
students can make the audio and online connections. You must manage multiple
presentation tools, engage students interactively, respond to questions, and
troubleshoot technical glitches — all in the restricted time frame of the scheduled
class session.

Like most new tools, the online collaboration tools require training and practice.
We recommend that you attend e-learning facilitation training for the e-learning
tool being used for delivery and rehearse your class presentations and
demonstrations. If using an IBM e-learning product, check http://www.ibm.com/
lotus/education for information about e-learning facilitation training.

Preparation checklist

After the course has been set up in the e-learning environment (see the E-
learning Setup section), you should:

Rehearse the presentation.

Reserve a conference services (do this if you will not use IP audio).
Conduct a connection test with students.

Review Preparing to Teach an e-Learning Session, in this section.
Review Delivering an e-Learning Session, in this section.
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E-learning Facilitator Preparation...(continued)

Rehearse the presentation

Create a test sesssion. Test and rehearse:

Presentation materials: Display each slide and practice delivering the
content as scripted in the Facilitator Guide.

Screen sharing demonstrations: This seminar requires you to perform
several interactive demonstrations from your workstation. As with any course,
you should rehearse these demos to ensure that they function well, you can
access the required applications, and you can smoothly transition between
the presentations and interactive demonstrations.

Reserve conference services

Course patrticipants connect to the course session using a Web browser. The
audio portion of the session can be heard from:

The speakers on the student's computer: The session must be enabled
for IP audio.

A telephone conference: Students use their telephones to listen and
participate in the session. A conference service is used to join all phone
connections into a conference. If your organization does not have its own
audio bridge facilities, you can make arrangements with a third-party vendor.
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E-learning Facilitator Preparation...(continued)

Reserve conference services...

Information you provide

Whether you use internal or vendor-provided conference services, you will need
to provide the following information:

Estimated number of participants: It is always better to overestimate, just
in case you have a few last-minute course registrants.

Origin of calls: Calls that originate in another country or time zone may
require different support or configuration on the part of the conference
provider. You should identify this in advance.

Contact name and number prior to the conference: If conference facility
personnel need to confirm or modify arrangements, they will need to contact
you.

Information you need

When you reserve the bridge facilities, you should confirm the following
information. This information will be communicated to students prior to the first
class:

22

Dial-in number for participants: This is the phone number that students will
dial.

International dial-in number (if needed): Some conference providers will
provide different dial-in numbers for international callers.

Conference reference name or number: Some conference service
providers connect callers to specific conferences. In these instances, the
caller dials a central number and identifies the desired conference using a
predefined conference number, title, or host (facilitator) name. The call is
then connected to the appropriate conference.

Password: Optionally, some providers may require a password for entrance
into a restricted conference.

Support resources: The conference provider may provide an additional
phone number for participants to call if they are having problems connecting
to the course.
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E-learning Facilitator Preparation...(continued)

Conduct a connection test

There are several reasons why you should request students to test their ability to
connect to the course — the least of which is to troubleshoot problems prior to
the first class.

Create a live session and schedule it to occur about one week prior to the
session. Invite students to join the session so that they can:

m  Test connectivity to the server.
m  Download any required applications or plug-ins.
m  Become familiar with the online interface.
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Preparing to Teach an e-Learning
Session

Preparing the course materials

When you prepare to teach a classroom-based course, you review the course
materials, rehearse demonstrations and presentations, and complete student
exercises. Preparing to teach a live session requires the same preparation with a
few additional tasks, including:

m Rehearsing interactive demonstrations: This course requires you to use
the screen sharing feature to share demonstration media files. You should
rehearse these interactive demonstrations several times.

m Rehearsing transitions: Several times during this course you are required
to switch from presenting slides to using screen sharing.

Assisting the facilitator

This seminar requires you to manage several tasks simultaneously. You must
display slides, demonstrate applications, and respond to questions, all while
maintaining flow and continuity. In addition, you may need to help students
manage their own display. For example, you may need to instruct a student on
how to recover a floating course screen, scroll the display, or scale a window's
image.

In addition, you must manage the pacing and interaction within the course;
monitor electronic and verbal hand raising; compose, send, and evaluate
guestions and answers; and fill time as you wait for applications to display. You
will also need to manage other, unscheduled events. For example, applications
may crash, displays may freeze, or you may unintentionally close a window.

All these events require your attention. It may be unreasonable, especially at
first, to manage the e-learning user interface while teaching the course
materials.
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Preparing to Teach an e-Learning Session...(continued)

Assisting the facilitator...

We strongly recommend, in addition to extensive preparation and rehearsal, that
you recruit a colleague to assist in delivering this course, at least the first time
you present it. Consider delegating the following roles and responsibilities:

Facilitator: This person presents the content and performs the interactive
demonstrations, paying attention to the flow and interaction of the course.
The facilitator:

Displays each presentation page.

Performs and narrates the interactive demonstrations.
Responds to verbal questions.

Manages the session pacing.

User Interface (Ul) manager: This person manages the elements of the
user interface. The Ul manager:

Monitors the display on a separate machine to ensure that the facilitator
narrative matches the refresh rate in the student browser.

Monitors the Participant List for raised hands.

m  Answers students questions regarding the Ul and any problems they may
be having with it.

You should rehearse each session with your partner and clearly define your roles
and responsibilities regarding each element of the presentations and interactive
demonstrations. Take a few minutes after each live session to review the things
that did and did not work.

© Copyright IBM Corporation 2008



IBM® Lotus® Symphony™ 1 Training Kit

Facilitator Guide

26

Preparing to Teach an e-Learning Session...(continued)

Preparing your e-learning podium

The e-learning delivery podium is very different from the classroom podium. You
can deliver this course from any workstation with a browser. You should also
examine the environment from which you deliver the class.

Review your setup.

Place a second computer next to your facilitator machine. Log on to this
second machine as a student

Using the second student machine, you can monitor what the students are
seeing; for example, how fast the refresh rate is.

Use the fastest machine you can for interactive demonstrations. Waiting for a
slow processor to perform your interactive demonstrations can be awkward.

Invest in a high-quality telephone headset. Your students will be listening to
you talk for hours at a time. Using a low-quality speakerphone or headset
can be irritating to listeners.

Listen to your environment.

Turn off the ringer on your phone and disable call waiting.

Disable voice paging on your phone, if you have this feature.

Disable the intercom.

Close the door (if you have one).

m Inform your colleagues and office neighbors of class dates and times.
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Preparing to Teach an e-Learning Session...(continued)

Preparing students

To prepare students, you should:

Invite students to attend a connection session prior to the beginning of
class. This allows students to:

Test their ability to connect to the session services.
Download any applications and plug-ins.
Get acquainted with the e-learning user interface.

Provide support: Students in a distributed learning environment require
several types of support:

Technical support: To help resolve connection issues.

Content support: To answer questions about the materials presented in
class.

Process support: To assure them that their participation in class is
appropriate.
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Delivering an e-Learning Session

Beginning the class

Before you begin:

Display the opening slide and dial into the conference services at least 15
minutes prior to the beginning of class. This will give students a chance to test
their connections. Use the draw tools to enter the time at which the class will
begin.

Arrange your workspace.

Clear the clutter on your desk; leave ample room for your Facilitator Guide,
notes, documentation, and so on.

Close any unused applications. They use valuable system resources.

m  Arrange the e-learning windows so that you can display all the required
functions.
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Delivering an e-Learning Session...(continued)

Pacing and interaction

Do the following:

Keep students engaged. Two hours of watching a presentation can put
even the most enthusiastic student to sleep. Add interaction where possible.

Survey your students, either verbally or by sending an electronic question.
Ask them about the level and pacing of your presentation. As with classroom-
based audiences, some students will have more advanced experience and
will benefit from less presentation and more demonstrations with verbal
guestions and answers. Others may require more remedial instruction. You
may not know this unless you ask.

Share the demonstration. When you share an application, as you do when
you demonstrate, you may be able to pass control to volunteers who can
complete tasks. Sharing the demonstration adds more activity in the class
and helps to engage students.

Pause for discussion. Ask your students to discuss the implications of a
specific function or feature. Be aware that discussions take time and you may
need to limit their scope and timing in order to stay within the session time.

Ask for volunteers. Be aware that some adult learners prefer to observe
and are uncomfortable when called upon to answer a question or perform an
exercise. If you initiate discussion or share an application, ask for volunteers
to electronically raise their hands. Then, select from those students.

Manage silence. It is fine to pause your presentation to catch your breath or
to wait for a slide to load. But remember that students have no visual contact
with you. If you are silent for too long, they may think they have lost their
audio connection. If you find that you are waiting a long time for an
application to perform a function, ask for questions, initiate a short
discussion, or review what you have done so far.
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Delivering an e-Learning Session...(continued)

Managing the visual display

Consider these tips:

Use the pointer tools to show bulleted list items.
If you distribute student materials, refer to the pages often.
Move your cursor slowly and deliberately.

Note: It is helpful to change the cursor style on your system, so it is easy for
students to identify it from their own.

m Do not use shortcut keys to initiate functionality, unless it is part of the
instructions. Student’s cannot follow you when you press ctrl-c but they can
follow you if you choose Edit-Copy.

m  Close demonstrations when they are complete. Start new demonstrations
from a neutral screen.
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Using IBM® Lotus® Symphony™
Documents: Basics

Lesson 1: Introduction to IBM® Lotus® Symphony™ Documents

Topic A: Getting Started with IBM® Lotus ® Symphony Documents
What Is Lotus Symphony Documents?
Exploring the Lotus Symphony Documents Interface
Examining the Properties Sidebar
Examining Preferences

Topic B: Creating Documents
Creating Blank Documents
Creating Documents from Templates

Topic C: Opening Existing Documents
Opening Lotus Symphony Documents
Opening Other Document Types
Opening Recently Accessed Documents

Topic D: Entering Text into Documents
Default Typing Features
Displaying Nonprinting Characters
Copying and Pasting Text
Moving Text
Changing Text and Paragraph Properties
Adding a Page Break

Topic E. Naming and Saving Documents
The Save As Command
The Save Command
Saving Files in Other Formats
Exporting Documents to PDF Format

Topic F: Finalizing Documents
Using the Spell Check Feature
Using Print Preview
Printing Documents

Lesson 2: Incorporating Lists and Tables in Documents

Topic A: Working with Lists
Defining List Types
Creating Lists
Formatting Lists

Topic B: Working with Tables
Creating Tables
Formatting Tables
Splitting and Merging Cells
Adding and Removing Rows and Columns
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Using IBM® Lotus® Symphony™

Documents: Beyond Basics

Lesson 1: Formatting Documents
Topic A: Specifying Page Properties

The Lotus Symphony Documents Page Properties Sidebar

Page Layout Properties
Page Background Properties
Page Header and Footer Properties
Page Border Properties
Column Properties
Footnote Properties
Numbering Pages
Topic B: Using Styles
Style Tips
Applying Styles
Creating Styles
Modifying Styles
Lesson 2: Adding Visual Elements to Documents
Topic A: Using Charts
Chart Types
Adding and Formatting a Chart
Modifying an Existing Chart
Topic B: Adding Graphics and Shapes
Adding a Graphic from the Gallery
Adding a Graphic from a File
The Graphic Properties Sidebar
The Drawing Toolbar
Adding Lines and Shapes
The Shape Properties Sidebar
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Using IBM® Lotus® Symphony™
Documents: Power User

Lesson 1: Working with Large Documents
Topic A: Working with Large Documents

Importing a File

Exporting a File

Inserting Calculations in a Document
Inserting Footnotes or Endnotes
Creating a Table of Contents
Creating an Index

Securing a Document

Installing and Using Plug-Ins

Topic B: Collaborating on Documents

Recording Changes

Accepting and Rejecting Changes
Using Comments

Merging Document Versions
Performing a MailMerge

Topic C: Using Navigator

Navigate Through a Document
The Form Navigator
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Using IBM® Lotus® Symphony™
Presentations: Basics

Lesson 1: Introduction to IBM® Lotus® Symphony™ Presentations
Topic A: Getting Started with IBM® Lotus® Symphony™ Presentations
What is Lotus Symphony Presentations?
Exploring the Lotus Symphony Presentations Interface
Examining the Properties Sidebar
Examining Preferences
Topic B. Creating, Opening, and Saving Presentations
Creating a Blank Presentation
Creating a Presentation from a Template
Opening an Existing Presentation
Saving a Presentation
Exporting a Presentation
Lesson 2: Modifying Pages in IBM® Lotus® Symphony™ Presentations
Topic A. Modifying Text
Adding Bullet and Numbered Lists
Inserting Symbols or Special Characters
Inserting a Text Box
Applying Presentation Styles
Changing Text Properties
Dragging Text to a New Location
Finding and Replacing Text
Topic B. Working with Views
Page View
Outline View
Page Sorter View
Notes View
Topic C. Working with Pages
Inserting a New Page
Duplicating an Existing Page
Reordering Pages
Deleting Pages
Hiding Pages
Lesson 3: Delivering an Pages in IBM® Lotus® Symphony™ Presentations
Screen Show
Topic A. Finalizing a Presentation
Page Transitions
Animating Page Transitions
Creating Notes Pages
Checking Spelling
Topic B. Delivering a Screen Show
Running a Screen Show
Printing a Presentation
Exporting a Presentation
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Using IBMe Lotuse Symphony-
Presentations: Beyond Basics

Lesson 1: Formatting a Presentation
Topic A. Formatting Slides
Setting Page Properties
Applying Slide Layouts
Changing Color Schemes
Adding Headers and Footers
Topic B. Using Templates
Importing a Template
Applying a Template
Saving a Presentation as a Template
Lesson 2: Adding Tables and Charts
Topic A. Adding Tables
Creating a Table
Inserting and Deleting Rows and Columns
Changing Row Height and Column Width
Merging or Splitting Cells
Formatting Tables
Topic B. Adding Charts
Inserting a Chart
Editing Charts
Formatting Charts
Topic C. Adding Graphics and Shapes
Adding a Graphic from the Gallery
Adding a Graphic from a File
The Graphic Properties Sidebar
The Drawing Toolbar
Adding Shapes and Lines
Animating Text with Graphical Effects
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Using IBMe Lotuse Symphony-
Presentations: Power User

Lesson 1: Customizing a Presentation

Topic A. Customizing a Presentation
Slide Masters
Modifying Slide Masters
Creating a Custom Screen Show
Installing and Using Plug-ins

Topic B. Working with Objects and Layers
Editing Bitmap Graphics
Converting Objects
Animating Graphical Objects on Pages
Layers
Inserting a Layer
Moving Objects to Layers
Hiding and Showing a Layer
Locking a Layer
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Using IBMe Lotuse Symphony-
Spreadsheets: Basics

Lesson 1: Introducing IBM® Lotus® Symphony™ Spreadsheets
Topic A. Getting Started with IBM® Lotus® Symphony™
Spreadsheets

What is Lotus Symphony Spreadsheets?
The Lotus Symphony Spreadsheets Interface
The Properties Sidebar
Examining Preferences
Creating a Spreadsheet
Creating a Spreadsheet from a Template
Opening an Existing Spreadsheet
Saving a Spreadsheet
Topic B. Adding Content to A Spreadsheet
Enter Data
Insert and Edit Notes
Rotating Text
Writing Multi-line Text
Inserting Special Characters
Formatting Text
Displaying Formulas or Values
The Formula Bar
Copying Formulas
Filling Cells Instantly
Calculating in Lotus Spreadsheets

Lesson 2: Formatting and Printing an IBM® Lotus® Symphony™

Spreadsheet
Topic A. Formatting Cells

Inserting and Deleting Rows, Columns, and Cells

Selecting Multiple Cells

Merging and Splitting Cells

Cell Borders

Changing Row Height or Columns Width
Topic B. Formatting Numbers

Numbers with Decimals

Number Formats

Formatting Numbers as Text

Using Rounded Off Numbers

Highlighting Negative Numbers

Changing Currency Format for Cells
Topic C. Printing a Spreadsheet

Basic Print Options

Printing Rows or Columns on Every Page

Printing Sheet Details

Printing Multiple Sheets
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Using IBMe Lotuse Symphony-
Spreadsheets: Beyond Basics

Lesson 1: Formatting and Protecting IBM® Lotus® Symphony™
Spreadsheets
Topic A. Specifying Page Formatting
Page Style
Page Borders
Page Background
Headers and Footers
Freezing Rows or Columns as Headers
Topic B. Formatting Sheets
Creating Sheets
Renaming Sheets
Copying or Moving Sheets
Deleting Sheets
Navigating Through Sheet Tabs
Rotating Sheet Columns and Rows
Topic C. Protecting Cells and Sheets
The Instant Corrections Property
Protecting Sheets and Cells
Lesson 2: Adding Content and Visual Elements
Topic A. Entering Values and Formulas
Calculating with Dates and Times
Calculating Time Differences
Entering Fractions
Entering a Number with Leading Zeros
Applying Sort Lists
Applying Filters
Entering Matrix Formulas
Topic B. Using Charts
Creating a Chart
Formatting Charts
Modifying a Chart’s Display
Using a Lotus Symphony Spreadsheet Chart in a Lotus
Symphony Document
Topic C. Adding Graphics and Shapes
Adding a Graphic from the Gallery
Adding a Graphic from a File
The Graphic Properties Sidebar
The Drawing Toolbar
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Using IBMe Lotuse Symphony-
Spreadsheets: Power User

Lesson 1:Working with Advanced Calculations Tools
Topic A. Working with Advanced Calculation Tools
DataPilot Tables
Consolidating Data
Solving Equations
Applying Multiple Operations
Defining Validity for Cell Contents
Lotus Symphony What If
Topic B. Using References
Naming Cells
Relative Addressing
Absolute Addressing
Referencing a Cell in a Different Sheet
Topic C. Collaborating on Spreadsheets
Tracking Changes
Adding Comments
Accepting or Rejecting Changes
Spreadsheet Navigator
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This information was developed for products and services offered in the U.S.A. IBM may not offer
the products, services, or features discussed in this document in other countries. Consult your
local IBM representative for information on the products and services currently available in your
area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may be used instead.
However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product,
program, or service. IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you any license to
these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
U.S.A.

The following paragraph does not apply to the United Kingdom or any other country where
such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES
CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND,
EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you. This information could include
technical inaccuracies or typographical errors. Changes are periodically made to the information
herein; these changes will be incorporated in new editions of the publication. IBM may make
improvements and/or changes in the product(s) and/or the program(s) described in this publication
at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do
not in any manner serve as an endorsement of those Web sites. The materials at those Web sites
are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate
without incurring any obligation to you.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products
and cannot confirm the accuracy of performance, compatibility or any other claims related to non-
IBM products. Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business operations. To
illustrate them as completely as possible, the examples include the names of individuals,
companies, brands, and products. All of these names are fictitious and any similarity to the names
and addresses used by an actual business enterprise is entirely coincidental.

This information may contain sample application programs in source language, which illustrates
programming techniques on various operating platforms. You may copy, modify, and distribute
these sample programs in any form without payment to IBM, for the purposes of developing, using,
marketing or distributing application programs conforming to the application programming interface
for the operating platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability,
serviceability, or function of these programs. You may copy, modify, and distribute these sample
programs in any form without payment to IBM for the purposes of developing, using, marketing, or
distributing application programs conforming to IBM's application programming interfaces.

If you are viewing this information softcopy, the photographs and color illustrations may not
appear.
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